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Program Outcomes 

PO1 
Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex engineering problems. 

PO2 

Problem analysis: Identify, formulate, review research literature, and analyze complex engineering 

problems reaching substantiated conclusions using first principles of mathematics, natural sciences, 

and engineering sciences. 

PO3 

Design/development of solutions: Design solutions for complex engineering problems and design 

system components or processes that meet the specified needs with appropriate consideration for the 

public health and safety, and the cultural, societal, and environmental considerations. 

PO4 

Conduct investigations of complex problems: Use research-based knowledge and research 

methods including design of experiments, analysis and interpretation of data, and synthesis of the 

information to provide valid conclusions. 

PO5 

Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modeling to complex engineering activities with 

an understanding of the limitations. 

PO6 

The engineer and society: Apply reasoning informed by the contextual knowledge to assess 

societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to the 

professional engineering practice. 

PO7 

Environment and sustainability: Understand the impact of the professional engineering solutions 

in societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable 

development. 

PO8 
Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms 

of the engineering practice. 

PO9 
Individual and team work: Function effectively as an individual, and as a member or leader in 

diverse teams, and in multidisciplinary settings. 

PO10 

Communication: Communicate effectively on complex engineering activities with the engineering 

community and with society at large, such as, being able to comprehend and write effective reports 

and design documentation, make effective presentations, and give and receive clear instructions. 

PO11 

Project management and finance: Demonstrate knowledge and understanding of the engineering 

and management principles and apply these to one’s own work, as a member and leader in a team, 

to manage projects and in multidisciplinary environments. 

PO12 
Life-long learning: Recognize the need for, and have the preparation and ability to engage in 

independent and life-long learning in the broadest context of technological change. 

Program Specific Outcomes (AE) 

PSO1 
Professional skills: Able to utilize the knowledge of aeronautical/aerospace engineering in 

innovative, dynamic and challenging environment for design and development of new products 

PSO2 

Problem-solving Skills: Imparted through simulation language skills and general purpose CAE 

packages to solve practical, design and analysis problems of components to complete the challenge 

of airworthiness for flight vehicles. 

PSO3 
Practical implementation and testing skills: Providing different types of in house and training and 

industry practice to fabricate and test and develop the products with more innovative technologies 

PSO4 

Successful career and entrepreneurship: To prepare the students with broad aerospace knowledge 

to design and develop systems and subsystems of aerospace and allied systems and become 

technocrats. 
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ATTAINMENT OF PROGRAM OUTCOMES & PROGRAM SPECIFIC OUTCOMES 

S No Experiment 
Program Outcome  

Attained 

Program Specific 

Outcomes Attained 

1 Introduction to computational structures PO1, PO2, PO3 PSO1, PSO3 

2 Introduction to ANSYS APDL PO1, PO2, PO3 PSO1, PSO3 

3 
APDL user interface, preprocessing, post 

processing & modeling. 
PO1, PO2, PO3 PSO1, PSO3 

4 
Static Analysis Of 2d & 3d Truss At Various 

Loading Conditions. 
PO2, PO3 PSO1, PSO3 

5 
Static analysis of different beams under various 

loading conditions. 
PO3, PO4 PSO1, PSO3 

6 
Static analysis of plate with a cutout for various 

materials. 
PO2, PO3 PSO1, PSO3 

7 
Modal & transient analysis of beams for various 

materials. 
PO2, PO3 PSO1, PSO3 

8 
Non-linear analysis of the mild steel beam for 

large deflection. 
PO2, PO3 PSO1, PSO3 

9 Harmonic analysis of the spring mass system. PO3, PO4 PSO1, PSO3 

10 Static analysis of aircraft wing structure. PO3, PO4 PSO1, PSO3 

11 Static and modal analysis of main landing gear. PO2, PO3 PSO1, PSO3 

12 Static analysis of composite beam and plate. PO2, PO3 PSO1, PSO3 
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COMPUTATIONAL STRUCTURAL ANALYSIS LABORATORY 

 

VII Semester: AE 

Course Code Category Hours / Week Credits Maximum Marks 

AAE111 Core 
L T P C CIA SEE Total 

0 0 3 1.5 30 70 100 

Contact Classes: Nil Tutorial Classes: Nil Practical Classes: 36 Total Classes: 36 

COURSE OBJECTIVES: 

The course should enable the students to: 

I. Apply the basic principles learnt from pre-requisites subjects to solve the structural problem. 

II. Adopt any computational structural analysis software and learns how to perform analysis. 

III. Analyze structural problems related to Aerospace industry. 

IV. Interpret the results and how to apply them on the real-life structure. 

LIST OF EXPERIMENTS 

Week-l INTRODUCTION AND BASIC FUCTIONS  

a. Starting up of ANSYS/Nastran 

b. Description of user interface 

Week-2 STATIC ANALYSIS: TRUSS AND FRAME STRUCTURES 

a. 2-D truss structures 

b. 3-D truss structures 

 

Week-3 STATIC ANALYSIS: BEAMS 

a. Straight beams 

b. Tapered beams 

Week-4 STATIC ANALYSIS: TWO DIMENSIONAL PROBLEMS 

a. 2-D structure with various loadings 

b. 2-D structures with different materials 

c. Plate with hole 

Week-5 DYNAMIC ANALYSIS: MODAL AND TRANSIENT ANALYSES 

a. Modal analysis 

b. Transient Response (spring-mass system)  

Week-6 THERMAL ANALYSIS 

a. Bars and beams 

b. 2D structures 

Week-7 NON LINEAR ANALYSIS 

a. Nonlinear behavior (Large deflections) 

b. Nonlinear behavior (Materials) 
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Week-8 HARMONIC RESPONSE ANALYSIS 

a. Random Vibration Analysis of a Deep Simply-Supported Beam 

b. Harmonic Response of a Spring-Mass System 

 

Week-9 ANALYSIS OF AIRCARFT STRUCTURE: WING 

a. Static analysis of Aircraft wing structure 

b. Modal analysis of aircraft wing structure 

 

Week-10 ANALYSIS OF AIRCARFT STRUCTURE:FUSELAGE 

a. Static analysis of Aircraft Semi monoque fuselage structure 

b. Modal analysis of aircraft Semi monoque fuselage structure 

 

Week-11 ANALYSIS OF AIRCARFT STRUCTURE:LANDING GEAR  

a. Static analysis of main landing gear 

b. Modal analysis of main landing gear 

Week-12 ANALYSIS OF COMPOSITE STRUCTURES 

a. Static analysis of composite bar and beam 

b. Static analysis of composite plate 

 

Text  Books: 

1. Huei-Huang Lee, “Finite Element Simulations with ANSYS Workbench 16”, SDC publications, 2
nd

  

Edition, 2016. 

2. Anderson, William J “MSC/Nastran: Interactive Training Program” Wiley 1
st
 Edition 2015. 

 “ANSYS Mechanical APDL Basic Analysis Guide”,  ANSYS,Inc Release 16.0. 

Web References: 

1. https://www.ansys.com/services/learning-hub 

2. https://caeai.com/ansys-software-support/ansys-software/mechanical-simulation-software 
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WEEK – 1 

                                                                  INTRODUCTION TO ANSYS 

 

OBJECTIVES: 

a. To model of 2D truss and apply proper element type. 

b. To perform the static analysis of  2D truss. 

c. To study the behavior of truss under the applied loading condition. 

  

RESOURCE: 

ANSYS 16.0 Academic 

 

PERFORMING TYPICAL ANSYS ANALYSIS.  

The ANSYS program has many finite element analysis capabilities, ranging from a simple, 

linear, static analysis to a complex, nonlinear, transient dynamic analysis. The analysis guide 

manuals in the ANSYS documentation set describe specific procedures for performing 

analyses for different engineering disciplines. 

 

A typical ANSYS analysis has three distinct steps: 

 Build the model.  

 Apply loads and obtain the solution.  

 Review the results. 

BUILDING A MODEL 

Building a finite element model requires more of an ANSYS user's time than any other part of the analysis. 

First, you specify a job name and analysis title. Then, you use the PREP7 preprocessor to define the element 

types, element real constants, material properties, and the model geometry. 

 

SPECIFYING A JOB NAME AND ANALYSIS TITLE                                                                                                                                                                                                                                                                                           

This task is not required for an analysis, but is recommended. 

 

DEFINING THE JOB NAME  

The job name is a name that identifies the ANSYS job. When you define a job name for an analysis, the job 

name becomes the first part of the name of all files the analysis creates. By using a job name for each 

analysis, you insure that no files are overwritten. If you do not specify a job name, all files receive the name 

FILE or file, depending on the operating system.  

Command(s): /FILNAME  

GUI: Utility Menu>File>Change Job name 

DEFINING ELEMENT TYPES  

The ANSYS element library contains more than 100 different element types. Each element type has a unique 

number and a prefix that identifies the element category: BEAM4, PLANE77, SOLID96, etc. The following 

element categories are available 

DEFINING ELEMENT REAL CONSTANTS  

Element real constants are properties that depend on the element type, such as cross-sectional properties of a 

beam element. For example, real constants for BEAM3, the 2-D beam element, are area (AREA), moment of 
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inertia (IZZ), height (HEIGHT), shear deflection constant (SHEARZ), initial strain (ISTRN), and added 

mass per unit length (ADDMAS). Not all element types require real constants, and different elements of the 

same type may have different real constant values. 

DEFINING MATERIAL PROPERTIES  

Most element types require material properties. Depending on the application, material properties may be: 

 Linear or nonlinear 

 Isotropic, orthotropic, or anisotropic 

 Constant temperature or temperature-dependent. 

APPLY LOADS AND OBTAIN THE SOLUTION  

In this step, you use the SOLUTION processor to define the analysis type and analysis options, apply loads, 

specify load step options, and initiate the finite element solution. You also can apply loads using the PREP7 

preprocessor. 

 

APPLYING LOADS  

The word loads as used in this manual includes boundary conditions (constraints, supports, or boundary field 

specifications) as well as other externally and internally applied loads. Loads in the ANSYS program are 

divided into six categories: 

 DOF Constraints 

 Forces 

 Surface Loads 

 Body Loads 

 Inertia Loads 

 Coupled-field Loads  

You can apply most of these loads either on the solid model (key points, lines, and areas) or the finite 

element model (nodes and elements). Two important load-related terms you need to know are load step and 

sub-step. A load step is simply a configuration of loads for which you obtain a solution. In a structural 

analysis, for example, you may apply wind loads in one load step and gravity in a second load step. Load 

steps are also useful in dividing a transient load history curve into several segments. 

 

PRE LAB VIVA QUESTIONS: 
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WEEK – 2 

STATIC ANALYSIS OF TWO DIMENSIONAL TRUSS 

 

OBJECTIVES: 

a. To model of 2D truss and apply proper element type. 

b. To perform the static analysis of 2D truss. 

c. To study the behavior of truss under the applied loading condition. 

  

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION:  

  
  

PROCEDURE: 

Preferences: Structural 
 
Preprocessor: 
 
 Element  Add  Link  2D Spar 1  Ok 

 Real constants  Add Set1  Cross section area = 0.0064 m^2  Ok 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2.5e11  

PRXY = 0.28  Ok 

 Modeling  Create  nodes  Inactive CS  (0,0);(2,0);(4,0);(6,0); (0,2);(2,2);(4,2);(6,2)  Ok  

Elements  Auto numbered  Thru nodes  Join nodes with lines  Ok 

 

Solution: 

 Analysis Type  New analysis  Static  Ok 

 Define Loads  Apply  Structural  Displacement  On nodes  Ok  All DOF Constrained  

Ok  UY DOF constrained  Ok Force/Moments  On nodes  FY = -10  apply  FY = -3.5 

 apply  FX = -3.5  Ok 

 Solve  Current LS  Ok 

 

General Post Proc : 
 

 Plot results  Deformed Shapes  Deformed + Un deformed 

 RESULTS: 
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Problem Description: 

 

 

 

PROCEDURE: 

Preferences: Structural 
 
Preprocessor: 
 
 Element  Add  Link  Spar 8  Ok 

 Real constants  Add Set1  Cross section area = 8.3 m^2  Ok 



 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic Ex = 2.5e11 

 PRXY = 0.28  Ok 


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 Modeling  Create  nodes  Inactive CS  (0,0,0);(2,0,0);(2,0,2);(0,0,2)  Ok  Copy  nodes 

 Copy  Select Nodes  y=2  Ok 

 Copy  nodes  Select 2
nd

 set  y=2  Ok  Copy  nodes  Select 3
rd

 set  y=2  Ok Copy 

 nodes  Select 4
th
 set  y=2  Ok 



 Modeling  Elements  Auto numbered  Thru nodes  Join nodes with lines  Ok 

 
Solution: 
 Analysis Type  New analysis  Static  Ok 



 Define Loads  Apply  Structural  Displacement  On nodes  Ok  All DOF Constrained  

Ok Force/Moments On nodes  FX = 10  apply  Ok 



 Solve  Current LS  Ok 

 

General Post Proc: 

 

 Plot results  Deformed Shapes  Deformed + Un deformed 

 

RESULTS:  
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PRE LAB VIVA QUESTIONS: 

a. What is Truss? 

b. Which type of loads does the truss take? 

c. What are methods to solve the truss analytically? 

d. Differentiate hinge supports and roller supports. 

 

LAB ASSIGNMENT: 

e. A truss of span 9m is loaded as shown in figure. Find the deflection of truss. 

 
f. A truss is as shown in figure. Find the forces in all members of the truss and indicate it is in tension or 

compression. 

 
 

POST LAB VIVA QUESTIONS: 

  

a. How do you select the element type in static analysis? 

b. Define elements and nodes? 

c. What type of analysis is done to solve the problem? 
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WEEK – 3  

STATIC ANALYSIS OF BEAMS 

OBJECTIVE: 

a. Understand the ANSYS APDL working plane. 

b. Write a Python script to print the Fibonacci series using functions. 

c. Write a Python script to find the GCD of two numbers. 

 

RESOURCE: 

ANSYS 16.0 Academic  

 

PROBLEM DESCRIPTON: 

 
 

  

PROCEDURE: 

 

Preferences : Structural 
 
Preprocessor : 
 
 Element  Add  Beam3 

 Real constants  Add Set1  Cross section area = 100 cm^2  Izz = 833.33 cm^4  Height = 10 cm 

 Ok  Close 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2.5e7  

PRXY = 0.28  Ok 

 Modeling  Create  Key points  Inactive CS  (0,0,0);(100,0,0);(150,0,0)  Ok  Lines  

Straight Lines  Ok 

 Meshing  Size Controls  Manual Sizing  Lines  Picked Lines  No. of elements = 20  Ok  

Mesh  Lines  Ok 

 

Solution : 

 Analysis Type  New analysis  Static  Ok 

 Define Loads  Apply  Structural  Displacement  On Key Points  Ok  All DOF Constrained 

 Ok  Force/Moments  On Key Points  FY = - 10000  Ok 

 Solve  Current LS  Ok 

 

General Post Proc : 

 Plot results  Deformed Shapes  Deformed + Un deformed 

 Contour Plots  Nodal Solutions  DOF Solution  Y- Component Displacement  Ok 
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RESULTS: 

 
 

PROBLEM DESCRIPTION: 
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PROCEDURE: 

 

 Preferences : Structural 
 
Preprocessor : 
 
 Element  Add  Beam3 

 Real constants  Add Set1  Cross section area = 144 cm^2  Izz = 1728 cm^4  Height = 12 cm  

Ok  Add Set2  Cross section area = 64 cm^2  Izz = 341.33 cm^4  Height = 8 cm  Ok  

Close 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2.5e7  

PRXY = 0.28  Ok 

 Modeling  Create  Key points  Inactive CS  (0,0,0);(100,0,0);(150,0,0) Ok  Lines  

Straight Lines  Ok 

 Meshing  Mesh Attributes  Picked Lines  Ok  Real Constant set No.1  Ok  Picked Lines  

Ok  Real Constant set No.2  Ok  Size Controls  Manual Sizing  Lines  Picked Lines  

No. of elements = 10  Ok  Mesh Lines  Ok 

 

Solution: 

 Analysis Type  New analysis  Static  Ok 

 Define Loads  Apply  Structural  Displacement  On Key Points  Ok  All DOF Constrained 

 Ok  Force/Moments  On Key Points  FY = - 5000  Ok 

 Solve  Current LS  Ok 

 

General Post Proc: 

 Plot results  Deformed Shapes  Deformed + Un deformed 

 Contour Plots  Nodal Solutions  DOF Solution  Y- Component Displacement  Ok 
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PRE LAB VIVA QUESTIONS: 

a. What is beam? 

b. Which type of loads does the beam can carry? 

c. What are the different type of beams?  

d. What is slope? 

e. Define bending moment. 

 

LAB ASSIGNMENT: 

d. A beam of length 6m is simply supported at its ends. It carries a uniformly distributed load of 10kN/m as 

shown in the figure. Determine the deflection of the beam at its mid-point and also the position and 

maximum deflection. 
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e. A cantilever of length 2m carries a uniformly distributed load of 2m carries a uniformly varying load of 

25kN/m at the free end to 75 kN/m at the fixed end. If E=1×10
5
N/mm

2
 and I=10

6
 mm

4
, determine the 

deflection of the cantilever at the free end. 

 
 

POST LAB VIVA QUESTIONS: 

f. How many degrees of freedom does the support have for SSB? 

g. What kind of mesh technique is used for meshing the beam? 

h. Differentiate uniformly distributed load and uniformly varying load. 
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WEEK – 4 

STATIC ANALYSIS OF TWO DIMENSIONAL STRUCTURES 

 

OBJECTIVES: 

a. To model the 2dimensional structure in ANSYS software. 

b. To perform the static analysis on 2 dimensional structure and study its behavior. 

 

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

PROCEDURE: 

 

Preferences: Structural 
 
Preprocessor: 

 

 Element  Add  Solid  Quad 4 node 42  Ok  Options  Element Behavior = Plane stress w/thk  

Ok 

 Real constants  Add Set1  THK = 3 mm  Ok  Close 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 0.7e5  

PRXY = 0.32  Ok 

 Modeling  Create  Areas  Rectangle  By Centre and Corner  PX = 0,PY = 0, Width = 50, Height 

= 30  Ok  Circle  Two end pts (-10,0),(10,0)  Ok 

 Operate  Booleans  Subtract  Select Area  Ok 

 Meshing  Size Controls  Manual Sizing  Areas  All Areas  Element Edge Length = 5  Ok  

Mesh  Areas  Free  Ok 

 

Solution: 

 

 Analysis Type  New analysis  Static  Ok 

 Sol’n Controls  Automatic Time Stepping = On  No. of Sub-steps = 5  Max. No. of Sub-steps = 1000 

 Min. No of Sub-steps = 1  Ok 

 Define Loads  Apply  Structural  Displacement  On lines  Ok  All DOF Constrained  Ok  

Pressure  On lines  100 N/(mm^2)  Ok 

 Solve  Current LS  Ok  
 

 

General Post Proc: 
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 Plot results  Deformed Shapes  Deformed + Un deformed 
 Contour Plots  Nodal Solution  Stress  X Comp.  Ok 
 Contour Plots  Nodal Solution  Stress  XY Shear  Ok 
 Contour Plots  Nodal Solution  Stress  Von Mises Stress  Ok  
 

Results: 
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PRE LAB VIVA QUESTIONS: 

a. Define stress concentration. 

b. What are different types of loads acting on a plate? 

c. Explain pure bending of thin plates. 

d. How does the bending moment vary in a plate with simply supported edge? 

e. Name different two dimensional elements. 

 

      LAB ASSIGNMENT 

  

a. Determine the stresses developed in following plate performing static analysis 

 

 

  

  

  

  

  

  

  

  

  

  

 

 

POST LAB VIVA QUESTIONS: 

a. Define stress concentration. 

b. What are Boolean operations? 

c. What are different types of loads acting on a plate? 

d. What are Von-misses stresses? 

e. Explain the elemental properties of Quad 4 node 42. 
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WEEK – 5 

MODAL ANALYSIS OF A BEAM 

 

OBJECTIVES: 

a. To learn how to perform modal analysis of a beam using Ansys software. 

b. To determine the natural frequency of the beam for free-free condition. 

 

RESOURCE: 

ANSYS 16.0 Academic 

  

PROBLEM  DESCRIPTION: 

 
 
 

PROCEDURE: 

 

Preferences: Structural 
 
Preprocessor: 

 Element  Add  Beam3 

 Real constants  Add Set1  Cross section area = 100 cm^2  Izz = 833.33 cm^4  Height = 10 cm  

Ok  Close

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2.5e7  

PRXY = 0.28  Density = 7800kg/(m^3) Ok 

 Modeling  Create  Key points  Inactive CS  (0,0,0);(100,0,0);(150,0,0)  Ok  Lines Straight 

Lines  Ok 

 Meshing  Size Controls  Manual Sizing  Lines  Picked Lines  No. of elements = 10  Ok  

Mesh  Lines  Ok  
 

Solution: 
 
 Analysis Type  New analysis  Modal  Ok 

 Analysis Option  Block Lancoz  No. of Modes to extract = 5  No. of Modes to expand = 5  Ok 

 Solve  Current LS  Ok 

 

General Post Proc: 
 

 Plot results  Deformed Shapes  Deformed + Un deformed 
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Results: 

 

 
 

 

 

 
 

 

 

 

 

 

 

 

 

 



23 | P a g e 
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PRE-LAB VIVA QUESTIONS: 

a. Define the term natural frequency. 

b. Classify various types of vibrations. 

c. What is mathematical model? 

d. What are different parts of basic spring-mass system? 

 
LAB ASSIGNMENT: 
e. Determine the natural frequencies of the following 3D truss. 

 

 
  

POST-LAB VIVA QUESTIONS: 

a. What are the h and p versions of finite element method? 

b. What is difference between static and dynamic analysis? 

c. What is CST element? 

d. Explain about Block Lancoz method. 
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WEEK – 6 

HARMONIC ANALYSIS 

 

OBJECTIVES: 

a. To perform the time variant analysis of a cantilever beam. 

b. To interpret the results of the transient analysis and study the behavior of the beam. 

  

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

  

PROCEDURE: 

Preferences: Structural 
 
Preprocessor: 
 
 Element  Add  Beam 3 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2e11  PRXY = 

0.33  Density = 7850kg/(m^3) Ok 

 Modeling  Create  Key points  Inactive CS  (0,0,0);(100,0,0)  Ok  Lines  Straight Lines  Ok 

 Meshing  Size Controls  Manual Sizing  Lines  Picked Lines  No. of elements = 20  Ok  Mesh  

Lines  Ok 

 Select parameters select functions define 

 

Solution: 

 Analysis Type  New analysis Transient  Ok 

 Parameters functions define/edit type in result= 1000 k sin({pi}/4*{time}) 

 Select file file name= transient desktop save

 Parameters functions read from file open transient give table parameter name cantilever

 Select loads define loads apply structural displacement on keypoints all DOF keypoint 1 

ok

 Solve  Current LS  Ok

 

Results  
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PRE-LAB VIVA QUESTIONS: 

a. What are damped vibrations? 

b. What is difference between damped and undamped vibrations? 

c. What happens to the response of an undamped system at resonance? 

d. What is self excited vibration? 

e. What assumptions are made about the motion of a forced vibration with non-viscous damping in finding the 

amplitude? 

f. Why is viscous damping used in most cases rather than other types of damping? 

 

LAB ASSIGNMENT: 

a. Compute the total response of spring-mass system with the values given below and plot the response for 10 
seconds 

Parameter Value 

k 1000 N/m 

m 10 kg 

F0 100 N 

ω 8.16rad/s 

x0 0.01m 
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ν0 0.01m/s 

 
POST-LAB VIVAQUESTIONS: 
a. How do you find the response of a viscously damped system? 

b. What assumptions are made about the motion of a forced vibration with non-viscous damping in finding the 

amplitude? 

c. What happens to the response of an undamped system at resonance? 

d. What is the frequency of the response of a viscously damped system when the external force is F0 sin ωt? Is 

this response harmonic? 

e. What assumptions are made about the motion of a forced vibration with non-viscous damping in finding the 

amplitude? 

f. Why is viscous damping used in most cases rather than other types of damping? 
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WEEK – 7 

ANALYSIS OF AIRCRAFT WING STRUCTURE 

OBJECTIVES: 

a. To perform the static structural analysis of a aircraft wing. 

b. To study the shear stress distributions over the wing surface. 

  

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

  

  Perform the static analysis of aircraft wing of span 550m and taper ratio 0.4.

 

PROCEDURE: 

Preferences: Structural 
 
Preprocessor: 
 
 Element  Add  Beam 3 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2e11  PRXY = 0.33 
 Density = 7850kg/(m^3) Ok 

 Modeling  Create  Key points  Inactive CS  (0,0,0);(100,0,0)  Ok  Lines  Areas  Ok 

 Meshing  Size Controls  Manual Sizing  Lines  Picked Lines  No. of elements = 20  Ok  Mesh  

Lines  Ok 

 Select parameters select functions define 

 

Solution: 

 Analysis Type  New analysis Transient  Ok 

 Parameters functions define/edit type in result= 1000 k sin({pi}/4*{time}) 

 Select file file name= transient desktop save

 Parameters functions read from file open transient give table parameter name cantilever

 Select loads define loads apply structural displacement on keypoints all DOF keypoint 1 

ok

 Solve  Current LS  Ok

 

Results  

 
 

PRE-LAB VIVA QUESTIONS: 
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a. What is taper ratio? 

b. What are the different types of  wings?  classify 

 

LAB ASSIGNMENT: 

 

a. Perform the aircraft wing modal analysis of span 300 m and taper ratio 0.5 and study its behavior. 

 

 

POST-LAB VIVA QUESTIONS: 

 

a. What are the types of meshing we have in Ansys workbench? 

b. Which type of mesh is used to solve wing? 
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WEEK – 8 

ANALYSIS OF AIRCRAFT WING STRUCTURE 

OBJECTIVES: 

a. To perform the static structural analysis of a aircraft wing. 

b. To study the shear stress distributions over the wing surface. 

  

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

  

 Perform the static analysis of aircraft wing of span 550m and taper ratio 0.4.PROCEDURE:

Preferences: Structural 
 
Preprocessor: 
 
 Element  Add  Beam 3 

 Material Properties  Material Models  Structural  Linear  Elastic  Isotropic  Ex = 2e11  PRXY = 

0.33  Density = 7850kg/(m^3) Ok 

 Modeling  Create  Key points  Inactive CS  (0,0,0);(100,0,0)  Ok  Lines  Areas  Ok 

 Meshing  Size Controls  Manual Sizing  Lines  Picked Lines  No. of elements = 20  Ok  Mesh  

Lines  Ok 

 Select parameters select functions define 

 

Solution: 

 Analysis Type  New analysis Transient  Ok 

 Parameters functions define/edit type in result= 1000 k sin({pi}/4*{time}) 

 Select file file name= transient desktop save

 Parameters functions read from file open transient give table parameter name cantilever

 Select loads define loads apply structural displacement on keypoints all DOF keypoint 1 

ok

 Solve  Current LS  Ok

Results  

 
 

PRE-LAB VIVA QUESTIONS: 

 

a. What is taper ratio? 

b. What are the different types of  wings?  classify 

 

LAB ASSIGNMENT: 

 

b. Perform the aircraft wing modal analysis of span 300 m and taper ratio 0.5 and study its behavior. 
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POST-LAB VIVA QUESTIONS: 

 

a. What are the types of meshing we have in Ansys workbench? 

b. Which type of mesh is used to solve wing? 
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WEEK – 9 

ANALYSIS OF LANDING GEAR 

 

OBJECTIVE: 

 

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

 Analyze the landing gear structure with applied load of 10000N 

 

PROCEDURE: 

Preferences ► Structural ► H-Method ► OK 

Preprocessor ► Element Type ► Add ► Add ► Select Link ► 2D spar 1 ► Apply Preprocessor ► Element 

Type ► Add ► Add ► Select Beam ► 2 Node 188 ► OK ► Close Real Constants ► Add ► Add ► Select 

Type Link 1 ► Click OK 

Enter the cross sectional area =1 ► OK ► Close 

Material Properties ► Material Models ► Structural ► Linear ► Elastic ► Isotropic Enter the Young’s 

Modulus (EXY) = 3e7 

Poisson’s Ratio (PRXY) = 0.3 

Sections ►Beam ►Common Sections ►Subtype ► Select Solid Circle R=0.5 

N=20 

T=0, Mesh view 

 

Preprocessor ► Modeling ► Create ► Key points ► In Active CS ► 
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Create the key points according to the table 

KP no X Y Z 

1. 0 0 0 

2. -12 0 0 

3. 12 0 0 

4. 0 -12 0 

5. 0 -12-12 0 

6. 0 
-12-12-

12 
0 

Modeling ► Create ► Lines ► Lines ► Straight Lines ► 

 

Join the key points according to table 

 

Line no Join 

1. 1 & 4 

2. 4& 5 

3. 5& 6 

4. 2& 5 

5. 3& 4 

 

Preprocessor ► Meshing ► Mesh Attributes ► All lines ► 

Select element type Beam 188, Ok Meshing ► Mesh tool► set ►Global 

1Link1►Ok Lines►set►3&4 line click►2&5 line click►ok No of divisions 1►ok 

Mesh Tool►Mesh►Mesh only strut►ok Meshing ► Mesh tool► set ►Global 

2 Beam 188►Ok 

Lines►set►1&4 line click►4&5 line click►5&6 line click►ok Element egde length►1►ok 

Mesh Tool►Mesh►Mesh only Vertical line►ok 

 

Main menu► plot Cntrls ► Style ► Size and Shape 

Click in the box against Display Element Type, 

 
 

Solution ► Define Loads ► Apply ► Structural ► Displacement ► On key Points ► Select keypoints 2 

& 3►select UX,UY,UZ,ROTX,ROTY►Ok 

Select keypoints 2 & 3►select UX,UZ►Ok 

Modeling >Create>Nodes>Rotate nodes CS>By angles>click 6
th
 keypoint THXY >60>ok 

Loads>Apply>Structural>Force/Moment>click On nodes 28/Key point 6> Force/Moment value >10000 
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Solution ► Solve>General Post proc>List results>Rection solution> Plot results:Defromed shape 

 
Results: 

 

PRE-LAB VIVA QUESTIONS: 

 

a. What do you mean by stack overflow? 

b. What are the basic operations of a stack? 

c. How to implement stack? 

 

LAB ASSIGNMENT: 

 

d. Analyze the given landing gear as shown in the below figure structure with applied load of 10000N 
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POST-LAB VIVA QUESTIONS: 

1. Name the element type used for beams? 

2. Define Analysis and its Purpose? 

3. What are the modules in Ansys Programming? 

4. What are the Real Constants & Material Properties in Ansys? Explain? 
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WEEK – 10 

ANALYSIS OF FUSELAGE 

 

OBJECTIVE: 

a. To perform the variant analysis of a Aircraft fuselage. 

b. To interpret the results of the analysis and study the behavior of the Strucutre 

 

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

 To calculate the deformation of the aluminum fuselage section under the application of internal load of 

100000 Pa. 

 

PROCEDURE: 

PREPROCESSING 
 

STEP 1: From the Main menu select preferences Select structural and press OK 

STEP 2: From the main menu select Pre-processor 

 

Element type  Add / edit/Delete  Add  Solid – 10 node 92 Apply 

Add  Beam 2 Node 188  Apply  Add  Shell Elastic 4 node 63 

 

Real Constants  Add  Select shell  give thickness (I) = 1 ok  close. 

 

Material properties  material models  Structural  Linear  Elastic  Isotropic EX = 0.7e11; PRXY = 

0.3; Density = 2700 

STEP 3: From the main menu select Pre-processor 

 

Pre-processor  modelling  Create  Areas  Circle  Annulus WP x = 0 ; WP y = 0; Rad – 1 = 2.5; Rad -

2 = 2.3 OK 

Pre-processor  Modelling  Create  Circle  Solid – 

 

WP x = 0; X = 2.25; Y = 0 Radius = 0.15 Apply WP x = 0; X = -2.25; Y = 0 Radius = 0.15 

 Apply WP x = 0; X =0; Y = 2.25; Radius = 0.15

 Apply WP x = 0; X = 0; Y = -2.25 Radius = 0.15 

 OK 

Pre-processor  Modelling  Operate  Booleans  Add  Areas – Pick all OK Pre-processor  Modelling 

 Operate  Extrude  Areas  By XYZ offset 

X= 0; Y=0; Z = 5 

STEP 4: Meshing the Geometry 

Pre-processor Meshing  Size controls  Manual Size  All Areas  give element edge length as 0.15  

ok 

Meshing  Size controls  Manual Size  All lines  give element edge length as ok 

Meshing  Mesh  areas  free  select box type instead of single  select the total volume  ok 
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SOLUTION PHASE: 

STEP 5: From the ANSYS main menu open Solution 

STEP 6: Loads  define loads  Apply  Structural  Displacement  On areas  select box type  select 

box (4 points at centre)  all DOF  ok Select  ALL DOF arrested 

Define loads  Apply  Structural  Pressure  on areas  select the internal  surface of the fuselage and 

give value (100000)  ok 

STEP 7: Solving the system Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS  

RESULT: 

Case: 1:- To Calculate the deformation of the aluminum fuselage section under the application of internal load at 

1e5. 

 

Y COMPONENT OF DISPLACEMENT 

 

DMX = .194E-04 SMN = -.194E-04 SMX = .194E-04 

VON MISSES STRESS 

DMX = .194E-04 SMX = .124E+07 

 

 

PRE-LAB VIVA QUESTIONS: 
a. What is conical lofting? 
b. Why is the fuselage on an airliner circular-shaped? 
c. Why do airliners have pressured bulk heads? 
  
POST-LAB VIVA QUESTIONS: 

1. Difference between interactive mode and batch mode. 

2. What are different types of structural analysis used in ansys? 

3. What are the different types of thin walled beams? 

4. Define Harmonic analysis. 
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WEEK – 11 

THERMAL ANALYSIS 

OBJECTIVE: 

a. To understand the thermal behavior of structural elements 

b. To Intermit the results of conduction convection and radiation phenomena of objects 

 

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

 The Simple Conduction Example is constrained as shown in the following figure.  

 

Thermal conductivity (k) of the material is 10 W/m*C and the block is assumed to be infinitely long. 

 
PROCEDURE: 

Open preprocessor menu 

ANSYS Main Menu > Preprocessor 
/PREP7 

Create geometry 

Preprocessor > Modeling > Create > Areas > Rectangle > By 2 Corners > X=0, Y=0, Width=1, Height=1 
BLC4,0,0,1,1 

Define the Type of Element 

Preprocessor > Element Type > Add/Edit/Delete... > click 'Add' > Select Thermal Mass Solid, Quad 4Node 55 
ET,1,PLANE55 

For this example, we will use PLANE55 (Thermal Solid, Quad 4node 55). This element has 4 nodes and a single 

DOF (temperature) at each node. PLANE55 can only be used for 2 dimensional steady-state or transient thermal 

analysis. 

Element Material Properties 

Preprocessor > Material Props > Material Models > Thermal > Conductivity > Isotropic > KXX = 10 (Thermal 

conductivity) 
MP,KXX,1,10 
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Mesh Size 

Preprocessor > Meshing > Size Cntrls > ManualSize > Areas > All Areas > 0.05 
AESIZE,ALL,0.05 

Mesh 

Preprocessor > Meshing > Mesh > Areas > Free > Pick All 

AMESH,ALL 

 

RESULTS: 

 
 

PRE LAB VIVA QUESTIONS: 

a. Define stress concentration. 

b. What are different types of loads acting on a plate? 

c. Explain pure bending of thin plates. 

d. How does the bending moment vary in a plate with simply supported edge? 

e. Name different two dimensional elements. 

 

LAB ASSIGNMENT 

  

a. Determine the stresses developed in following plate performing static analysis 
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POST LAB VIVA QUESTIONS: 

b. Define stress concentration. 

c. What are Boolean operations? 

d. What are different types of loads acting on a plate? 

e. What are Von-misses stresses? 

f. Explain the elemental properties of Quad 4 node 42. 
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WEEK – 12 

 ANALYSIS OF COMPOSITE STRUCTURE 

 

OBJECTIVE: 

 To create a composite structure in ANSYS Workbench 

 To perform the static analysis for various layers of composite beam. 

  

RESOURCE: 

ANSYS 16.0 Academic 

 

PROBLEM DESCRIPTION: 

  

  Perform the static analysis of composite cantilever beam of length 2m and having cross section 10cm×10cm

PROCEDURE: 

 Define draping for modeling groups  

 Connecting ACP to Static Structural Tools in Ansys 

 Doing Stress Analysis  

 Solving the model  

 Analyzing Data in static Structural  

 Analyzing Data in Post-Processing 

 

Results  

 
 
PRE-LAB VIVA QUESTIONS: 

a. Define tree traversal and mention types of traversal? 

b. Define a tree? 

c. Define height of a tree? 

d. Define depth of a tree? 

e. Define degree of a node? 

f. Define Degree of a tree? 

g. Define Terminal node or leaf node? 

h. Define Non-terminal node? 

i. Define Sibling? 

j. Define Binary Tree? 

k. Write the properties of Binary Tree? 

l. Find the minimum and maximum height of a binary tree? 

 

 
LAB ASSIGNMENT: 
a. Formulate a program to create a Binary Tree of integers? 
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b. Write a recursive program, for traversing a binary tree in preorder, inorder and postorder? 
c. Compose a non-recursive program, for traversing a binary tree in preorder, inorder and postorder? 

d. Write a program to check balance property of a tree? 

 
POST-LAB VIVA QUESTIONS: 
a. Write the balance factor of a Binary Tree? 
b. What is a spanning Tree? 
c. Define a Complete Binary Tree? 

d. List out the applications of Binary Tree? 

e. Write the two approaches for Binary Tree Traversal? 

f. Write the various operations performed in the binary search tree? 

g. List out few of the Application of tree data-structure? 

h. Define pre-order traversal. 

i. Define post-order traversal. 

j. Define in-order traversal. 


